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Introduction
Thank you for your interest in the Mandarin M3 Library Automation System. We have prepared this tutorial to
give you a tour of M3.
 
After you have imported bibliographic and patron records into M3, you can use this guide to familiarize yourself
with M3, to conduct training, etc. This guide is not intended to replace our Users Guide as it only briefly
touches on many of M3’s capabilities.
 
If you prefer to use Mandarin’s sample record database instead of importing your own records, we offer a version
of the M3 Server that includes sample patrons and bibliographic items. This version of M3 Server is available
through the same link as the free M3 download on the Mandarin Web site.
 
Note: ReportTool is available This tutorial will walk you through all M3 modules (except ReportTool):
 
•     Windows OPAC (Online Public Access Catalog)
•     Circulation
•     Cataloging
•     Group Editor
•     Inventory
 
In many cases, there are several ways to perform a function or command. For this tutorial, we have generally
chosen to present just one of the options
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Windows OPAC
 
OVERVIEW
 
Note: This tutorial  may not explain all features available in the OPAC.
 
With the Windows-based OPAC module, you can:
 
•     Conduct Standard, Enhanced, and Visual Catalog searches of your library’s holdings
•     Select different interface languages
•     Determine item availability and location
•     Work with search results in brief and expanded record formats
•     View book cover images
•     View and link to “See” and “See also” cross-references with the optional Authority Control module
•     Print records or save records to file
•     Add records to the Bookbag; print or save records in the Bookbag
•     Use Shelf Browse to locate records
•     Review your search session history and return to prior searches
•     Allow patrons to view their transaction history and personal information with the My Account tab
•     Enter or scan barcodes into the Bookbag to create a list of items
•     Use the Bulletin Board to deliver information to patrons
•     Customize the appearance of the OPAC with your library name
•     Customize the Visual Catalog interface
 
 
STARTING THE  OPAC
Open the Mandarin M3 folder on your desktop, then double-click the OPAC icon. This displays the main
OPAC window (Figure 2.1) with Standard Search selected.
 
FIGURE 2.1
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The  header  can be customized to display  the name of your library or institution.
 
Language Options
Patrons can change the interface language of the OPAC at any time; this does not change the language of
the information in the MARC records. Patrons may choose from English (default), French, Spanish, German,
and Italian.

Click Languages. This displays the Languages dialog box with the list of language choices.
 
Bulletin Board Feature
The Bulletin Board feature links to a local HTML file or a Web page. Use this fea- ture to link to customized
information, the library home page, or a page of public service announcements.

Click Bulletin Board. This displays a blank bulletin board.
 
To configure your bulletin board, click the Start button, select Programs, select Mandarin M3, select
Utilities, and then click Setup Bulletin Board. Follow the prompts.
 
STANDARD SEARCH
 
Tip: To ensure a successful search, M3 automatically searches as follows:

• The Subject field searches all Subject and Summary fields  of the MARC Record.
• The Title field searches Title, Added Title, Contents, and Notes fields  of the MARC Record.
• The Author  field searches Author, Added Author, and Responsibility Statement  of the MARC Record.

 
FIGURE 2.2
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Standard Search allows patrons to easily search your catalog with the familiar Subject, Title, or Author
fields. A patron can enter a search term in the keyword box or click Browse to view a list of all data currently
contained in the corresponding record index. M3 can be configured to search more or fewer fields of the
MARC record or to default to different record indexes at the librarian’s discretion.
 
Search Example 1
In the Subject keyword box, type a keyword, then click Search. This displays the Search Results list
(Figure 2.2).

•     A media type icon displays next to the call number of each record. Media type icons in this
results list include book, music, video, and Web site. Scroll through the search results list to view
titles.
•     When the mouse points to the media type icon, the icon type displays. (It may take a moment for
the text to display.)
•     A green box to the left of the record indicates that the item is avail- able; a red box indicates that
the item is not available. Clicking this box tags the record for functions such as printing or adding to
the Bookbag.

 
Tips:

• Click Sort to sort by Author, Call Number, Call Number by Prefix,  Copy- right  Date, or Title.
• Active Web links can be enabled in the OPAC by entering a Web address and optional description in the bibliographic
record.

 
If you add the optional Authority Control module to your M3 system, “See” and “See also” cross-references
  will display in the Cross-Reference box (shown in Figure 2.2). You will be able to view records associated
with a cross-reference by clicking the “See also” term.
 
Tip: Use the truncation asterisk (*), wildcard  ques- tion mark (?), and phrase quotation marks  (“ ”) with your keywords.
 
Examples:
• Farm* finds farms, farmer, farmers, farming, and so on.
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• Wom?n finds woman and women.
• “African American” only looks for the keywords when they appear next to each other. This eliminates false results in which the
words are listed separately.
 
Search Example 2

• Click the Search tab, and then click Clear.
• In the Title keyword box, type a title, and then click Search. This displays the Search Results list.
• Select a record, then click Record Details. This displays detailed information about the selected

title.

 
Search Example 3

• Click the Search tab, and then click Clear.
• In the Subject keyword box, type a keyword, and then click Search.
• Click the Search tab.
• Click the Browse button next to the Subject keyword box to display a list of subject headings

(Figure 2.3). This list allows you to narrow your search to a specific area of interest.

 
FIGURE 2.3

 

• Select a subject heading in the list, and then click OK. The selected term appears in the Subject
keyword box.

• Click Search to view the Search Results list for this subject.

 
Search Example 5

• Click the Search tab, and then click Clear.
• A patron can search the Author field by entering a name in any order: for example, Steinbeck,

John or John Steinbeck or just Steinbeck.
• In the Author keyword box, type any form of an author’s name and then click Search. This

displays the Search Results list. By default, the records display in bibliographic record format.
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Tip: Record Format allows patrons to choose the display format  that best suits their needs. Standard options include
Bibliographic, List, Full MARC, Catalog Card, Brief Labeled, Expanded Labeled, and Compressed List.
 

• To view other record format display options, click Record Format.

 
Select a different format to view, and then click OK.
OR
Click Cancel to close the Record Format dialog box.
 

• To view record details, select a record and then click Record Details. This

displays detailed information about the selected title and lists all copies owned by the library, as
shown in Figure 2.4.

 
FIGURE 2.4

 
Tip: Shelf Browse allows you to quickly find records with a call number similar to that of a selected record.  This feature creates
a virtual  electronic shelf and simulates a patron browsing the shelves and discovering books/items that may  not  be discovered
any other way.
 

• When finished reviewing the record details, click Back To Record List.

 
USING THE  BOOKBAG
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To create a reading list or bibliography, click the green/red check box to tag indi- vidual records in the Search
Results list. (Green indicates the item is available; red indicates unavailable.)

• Tag at least three records.
• Click Add to Bookbag, and then click Add Tagged.
• Click the Bookbag tab to view the records you added.

 
From here, you can print or save the list. You can also add records to the list by scanning or entering
barcodes, but this feature is not enabled by default; refer to the M3 Users Guide for instructions on enabling
this feature.
 
 
ENHANCED SEARCH
Tip: If a patron is not sure what index to search, the Enhanced Search index list includes the Anywhere option. This option
searches for the entered term anywhere in the MARC record.
 
Enhanced Search allows the user to type a search query into one or more of three keyword boxes. To select
different record indexes or Boolean operators, click the corresponding arrow button, and then select from
the list. (You can also use the Browse button to enter a search term, as explained in “Search Example 3” on
page 2-4.)
 
Search Example

• Click the Search tab, and then click Enhanced. This displays the Enhanced Search window
(Figure 2.5).

• In the first keyword box (under Subject), type shipwreck.
• In the Boolean operator list below, select OR.
• In the second index list, select Subject, then type treasure in the second keyword box.
• In the second Boolean operator list, select NOT.
• In the third index list, select Subject, then type titanic in the third keyword box (shown in Figure

2.5).

 
FIGURE 2.5
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Tip: The index lists can be customized  to display different indexes.
Tip: Click History to view a list of your  Enhanced Search queries during this session.
 

• Click Search. If matches are found, the Search Results list displays. Your options are the same as
those described in “Standard Search” beginning on page 2-3.

 
 
VISUAL CATALOG SEARCH
Visual Catalog Search combines library-definable queries that are organized into a hierarchy of topics and
subtopics utilizing graphics and text. This easily configurable graphical interface offers the following benefits:
 

•     Helps younger patrons quickly find library materials via visual cues, such as Animals or
Countries &  Cultures
•     Creates databases for special groups, faculty, and students, such as “Home Schoolers” or
“Rotary Club”
•     Queries special collections, such as “New Books,” “e-Books,” or “Video Collection”
•     Launches software applications, such as WordPad
•     Launches CD-ROM applications, such as an encyclopedia
•     Launches URLs (MARC field 856), such as “Featured Web Sites of the Week”

 
To perform a Visual Search:

• Click the Search tab, and then click Visual.
• Click each of the eight buttons featured in the Visual Catalog interface and tour on your own.

 
FIGURE 2.6
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Tips:

• M3 includes over 75 colorful graphics for use in the Visual Catalog. Additional graphics can be used from sources on the
Internet or your own files.
• Topic, query, and launcher buttons look alike. What they do when  selected differenti- ates them. A topic button opens a
sub-menu.  A query button returns search results. A launcher  button opens an application or a Web page.
• Two navigation buttons function as follows: Back returns to the previous menu level; Start Over returns  to the first
menu level.

 
 
DATABASES TAB
M3 can be configured to host the collections of a single library or the collections of many libraries either as
a Classic Merged Union Catalog or Virtual Union Catalog. The system can be configured to search the local
collection first and, if the desired record is not found, to then search other collections.
 
A patron can choose which collections to search by clicking the Databases tab. Click the Databases tab to
review layout.
 
MY  ACCOUNT TAB
This feature allows patrons to view their own open and closed transactions as well as their personal
information on file with the library. This tab is not enabled by default; refer to the M3 Users Guide for
instructions on enabling this feature.

• Click the My Account tab. This displays the My Login dialog box.
• In the Patron Barcode box, type a patron barcode that exists in the system. (If you are using

Mandarin’s sample record database, type P2.)
•
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In the Password box, type the patron’s password, then click OK. (If you are using Mandarin’s
sample record database, type demo.) This displays Open Transactions with any current, or
open, transactions that the library has on file for the patron. The Current button is now active.

• Click Historical to view closed or historical transactions.

 
You can also view patron contact information and a patron photo (if there is one on file), but this feature is
not enabled by default; refer to the M3 Users Guide for instructions on enabling this feature. After enabling,
a My Info button will appear in this window.
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Circulation
 
OVERVIEW
With the Circulation module, you can:
•     Conduct loans, returns, reserves, holds, bookings, renewals, and fine pro- cessing
•     Select different interface languages
•     View patron and item status
•     Add, edit, and search for patron and item records
•     Add book cover images and patron photos to records so they can be viewed in Circulation and OPAC
•     Temporarily change the system date
•     Set up one or more circulation schedules
•     Add and delete patron and item messages
•     Attach, edit, and detach messages to patron and item records
•     Enable self checkout, self return, and quick return
•     Send e-mail notifications to patrons who owe a fine or have overdue items.
•     Send automatic e-mail notifications to patrons when items they reserved are available
•     Track in-house usage
•     Run transactions reports
•     Upload transactions from portable scanners
•     Print receipts
 
 
STARTING CIRCULATION

• Open the Mandarin M3 folder on your desktop, then double-click the Cir- culation icon. This displays the
Login dialog box.

• In the Login Name box, type admin.
• In the Password box, type boca raton, and then click OK. This displays the main Circulation window

(Figure 3.1).

 
 
FIGURE 3.1
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•     Circulation  menu bar – Contains File, Mode, Patron, Item, Tools, Settings, and Help menus.
 
•     Circulation toolbar – Contains Loan (green), Return (red), Renew (blue), Reserve (yellow),
and Status (purple) functions. Click each of these buttons to observe the color change with each
function.
 
•     Shortcut toolbar – Contains buttons for commonly-used functions, such as adding an item or
patron, accessing circulation options and the schedule, and changing the interface language. Rest
your mouse pointer on each toolbar button for a moment to view a tooltip that explains the function
of each button. To turn the shortcut toolbar on or off for the current session, press CTRL+T.
 
•     Barcode  box – Allows you to type or scan a patron or item barcode, type a patron or author’s
last name, or type an item’s title to access the matching record.

 
Images can be added to patron and bibliographic records. Patron and item images will display in the
Circulation and OPAC modules.
 
CONDUCTING TRANSACTIONS
 
All circulation transactions are accessed from the main Circulation window. You can view patron and item
status, loan items, return items, renew items, reserve and hold items, book equipment and rooms, attach
patron and item messages, process fine payments, forgive fines, and record patron claims of lost, previously
paid, never had, and previously returned. Many of these procedures are covered in the following sections.
 
Loaning Items
There are three ways to access the loan function:

•     On the toolbar, click Loan.
•     On the Mode menu, click Loan.
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•     Press F5.
 
Tip: If a patron has a fine, a warning  appears. You can:

• Click Override to ignore the message and continue with the transaction.
• Click Payment to go to thePayment dialog box.
• Click Cancel to stop the transaction.

 
Tip: There are several methods for returning items:

• Single Return – Returning a single item from a patron.
• Multiple Return – Returning multiple items from  one patron.
• Return All – Returning all items listed.
• Quick Return  – Scanning in bookdrop returns without patrons present.
• In-House Circulation Return – Returning items left on tables and desks after in- library use.
 

Loan Example

• On the toolbar, click Loan.
• In the Barcode box, type a barcode or patron name, and then press ENTER.
• This displays information for the patron in the Patron pane. The Patron pane can be customized to

display any information that is stored in the patron record.
• In the Barcode box, type an item barcode, and then press ENTER to check out the first item.
• Type another barcode and press ENTER to check out a second item.

 
Returning Items
Returning  a Single Item

• On the toolbar, click Return.
• In the Barcode box, type the barcode of the item being returned, and then press ENTER. This

returns the item.

 
Returning  Multiple Items for the Same Patron

• On the toolbar, click Loan to reset the screen.
• In the Barcode box, type the patron’s barcode, and then press ENTER.
• In the Transactions pane, select the check boxes next to the items being returned.
• Right-click in the Transactions pane to access a transaction menu (shown in Figure 3.2).

 
 
FIGURE 3.2
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• Click Return. This batch-returns  all checked items.

 
NOTE: You can also return all loaned items by clicking Return  All on the transaction menu; you do not need to select the check
boxes next to the items.
 
Attaching a Message to  a Patron Record

• In the Barcode box, type a patron barcode, and then press ENTER.
• On the Patron menu, click Messages.

 
This displays a list of any messages in the system. You can select a message from the list or add a new
message for this patron.

• Click New. Type a message, click OK, and then click Accept.
• In the Block Type list (click the arrow to view the list), select Information as the block type, and then click

Accept.

 
This message will appear the next time this patron’s barcode is entered.
 

Message Block Types in M3

Information block – You can bypass the message by clicking
anywhere on the Circulation window (the least intrusive block type).

Nudge block – On first occurrence, you must select an option in
order to proceed. Any time this message appears again, it will act as
an information block.

Blocking block – You must select an option in order to proceed. Privilege block – You must type a password to bypass the message
(the most intrusive block type).
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Booking an  Item
Use the Booking feature to reserve an item such as a conference room, a piece of equipment, or group of
videos, for a future day and/or time. You can book an item for a single day, a range of days, or for specific days.

• On the toolbar, click Loan.
• In the Barcode box, type a patron’s barcode, and then press ENTER.
• On the Mode menu, click Booking.
• In the Barcode box, type the barcode of an equipment item that exists in the system, and then

press ENTER. This displays the Booking dialog box (Figure 3.3).

 
FIGURE 3.3

 
 
Tip: Click Hourly to display the current  day’s agenda. Click Daily  to return  the calendar to a two-month view.
 

• Click the first day you want the item and drag the mouse to the last day you want the item. Click
Add, and then click OK.

OR
Click Hourly, then click the first hour you want the item and drag the mouse to the last hour you
want the item. Click Add, and then click OK.
 

• To exit Booking mode, click Loan on the toolbar.

 
Locating a Patron

• Clear the Circulation window by pressing ESC.
• In the Barcode box, type a patron’s last name. This displays the Select Barcode box, which lists

all matches for this name.
• Select a patron and click OK. This displays the patron information in the Patron pane of the

Circulation window.
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Locating and  Loaning an  Item

• With a patron displayed in the Patron pane, type an item’s title in the Barcode box, and then
press ENTER.

 
This displays the bib and holding information in the Item pane of the Circulation window and loans the item
to the patron.
 
 
Setting Up  the  Library Calendar

• On the Tools menu, click Schedule. This displays the Circulation Schedule dialog box.
• Click each tab and review the contents.

•     General tab – Establishes loan period rules.
•     Schedule tab – (Shown in Figure 3.4) Establishes the calendar period and the library’s
opening and closing hour for each day of the week. Create multiple calendar periods to
apply to different times of the year.
•     Holidays &  Exceptions tab – Allows you to eliminate or add irregular dates. Identify
days when library is closed because of holidays, and so on.
•     Global Recalls tab – Allows you to specify the date when all items have to be back in
the library.

 
FIGURE 3.4

 

• When finished, click Cancel to close this dialog box.

 
 
Transaction Report Utility
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M3 provides basic transaction reports to monitor your library status and activity. On the Mode menu, click
Library Transactions.
 
In Figure 3.5, notice the All Transactions  header in the Transactions pane.
 
FIGURE 3.5

 
Tip: To resize the bottom pane to allow for easier viewing, drag “up” the bar at the top of the Transactions  pane.
 

• Right-click in the Transactions pane to open a shortcut menu with a list of report choices.
• Click Select Transactions. This displays the Select Transactions dialog box.
• Under Transaction Type, click Overdue Loans.
• Under Overdue Loans, click the second option and type 30 in the days or more box.
• Click OK.

 
Notice the header in the Transactions pane has changed.
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Cataloging
 
OVERVIEW
 
With the Cataloging module, you can:
•     Add, edit, delete, and search for MARC records
•     Use the find and replace utility to modify records
•     Import and export records, including pictures
 
STARTING CATALOGING

• Open the Mandarin M3 folder on your desktop, then double-click the Cataloging icon. This
displays the Login dialog box.

• In the Login Name box, type admin.
• In the Password box, type boca raton, and then click OK. This displays the main Cataloging

window (Figure 4.1).

 
EDITING AN  EXISTING RECORD

• On the Edit menu, click Search. This displays the Search dialog box.
• In the Search  For list, select Bibliographic.
• In the first index list, change Subject to Title.
• In the first keyword box, type the title of an item that exists in your system, and then click Search.

This updates the main Cataloging window with the records matching your search (Figure 4.1).

 
FIGURE 4.1

 
Tips:
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• You can sort information by any field in the pane by clicking the field’s column heading.
• The Holding records pane displays all copies linked  to the bibliographic record selected in the upper pane.
 

• Double-click the first bibliographic record in the Bibliographic records pane. This displays the
Bibliographic-Cataloging window with the selected record in full MARC format (Figure 4.2). The
record can now be edited.

 
FIGURE 4.2

 
Tip: Once you have clicked a MARC field to activate the record  pane,  you  can go to the end of a record by pressing CTRL+END. 
You can also  go to the beginning of a record by pressing CTRL+HOME.
 

• Right-click any field or subfield to access a context-sensitive menu for editing. In the menu, click
Toggle Prompts to switch the display of the MARC numeric tags to text fields.

• The Override Authority check box is available if you have purchased the
• optional Authority Control module. With this module, a window automatically appears when you

select a field containing a name, subject, or series heading. This window displays all headings
in your authority file valid for use in the selected field. You select the desired heading, and the
heading is then added to the bibliographic record and a link is created to the authority record.
Authorized users can edit an authority controlled bibliographic field directly by selecting the
Override Authority check box, then typing the new text in the field.

• Any errors or cataloging inconsistencies in the record appear in the Validation errors box on the
right. To view information explaining each error, click the plus (+) sign to the left of the error.

• Click Cancel to close the Bibliographic-Cataloging window.

 
 
CREATING A  DUPLICATE OF  AN  EXISTING HOLDING RECORD
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• In the main Cataloging window, double-click the holding record in the Holding records pane (lower
pane).

• Under After saving, click Duplicate. This creates a new holding record for an additional copy of
this book.

• Click Save. This displays a new Holding-Cataloging window containing the duplicate holding
record.

• In the lower pane, scroll to 852#p (barcode) and type a barcode in the field at right (as shown in
Figure 4.3).

 
FIGURE 4.3

 

• Click Save.
• Click Cancel to close the Holding-Cataloging window.

 
The main Cataloging window displays the newly created holding record in the Holding records pane beneath
the original holding record.
 
CREATING A  NEW BIBLIOGRAPHIC RECORD

• On the File menu, select New, and then click Bibliographic Record. This displays the Templates
window with the list of cataloging templates included with M3 (Figure 4.4). The templates can be
used in their current form or customized.

 
FIGURE 4.4
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• Select a template, then click OK. This displays the Bibliographic-Cataloging window.
• Type entries in the blank fields and subfields for the bibliographic record as desired.
• Click Save. This displays the Holding-Cataloging window with the newly created bibliographic

record in the top pane and the associated holding record in the bottom pane.
• Type entries in the blank fields and subfields for the holding record.
• Click Save.

 
The bibliographic and holding records have been created. You can now search for this title in the OPAC.
 
IMPORTING RECORDS
M3 Cataloging imports bibliographic and patron records in MARC, delimited, and fixed-width formats, and
authority records in MARC format. To import bibliographic records, for example, the user:
 
1.      Selects the records, fields, and subfields to import
2.      Specifies how fields are displayed
3.      Checks for duplicate records
4.      Generates holding records
5.      Updates barcodes
 
The import feature is not fully documented in this tutorial; however, Figure 4.5 and Figure 4.6 show samples
of the Step 1 and Step 2 windows in the import process.
 
FIGURE  4.5    
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FIGURE 4.6



Group Editor

© 2014 Mandarin Library Automation, Inc. All rights reserved.
 

25 of 35

Group Editor
 
OVERVIEW
M3 Group Editor enables the librarian to create, customize, and modify the group permissions required to
gain access to M3 functions. Using an elaborate, hierar- chical security scheme, librarians are able to assign
levels of access for Cata- loging, Circulation, OPAC, and database maintenance features.
 
There are three types of groups: Patron, Item, and Special Reserve. When dis- playing a group listing, a
group type icon appears to the left of each group:

•     a head signifies a patron group
•     a book signifies an item group
•     eyeglasses signify a special reserve group

 
 
STARTING GROUP EDITOR

• Open the Mandarin M3 folder on your desktop, then double-click the Group Editor icon. This
displays the Login dialog box.

• In the Login Name box, type admin.
• In the Password box, type boca raton, and then click OK. This displays the main Group Editor

window (Figure 5.1).

 
FIGURE 5.1

 
CREATING A  NEW GROUP
For this example, we will create a new special reserve group.

• In the main Group Editor window, click New. This displays the New Group dialog box (Figure 5.2).
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FIGURE 5.2

 

• Click New Special Reserve Group, and then click OK.

 
This places a New Special Reserve Group in the Group Editor window (Figure 5.3).
 
FIGURE 5.3

 
 

• Select the New Special Reserve Group, then click Edit.

 
This displays the Special Reserve Group window. Here, you can customize this group’s patron privileges
and item parameters.

• Click the General tab.
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• In the Name box, type Computer Awareness Program.
• In the Description box, type Sponsored by FBLA Club.
• Under Reserve Group Expiration, click Expires, and then select a date.
• Under Created by Patron Group, leave the entry as Administrators.
• Under Circulation Access Available to, click All Patrons.

 
FIGURE 5.4

 

• Click the Item Members tab.
• A message appears indicating that there are no records found. Click OK.
• In the Display list (under the tab names), select Search.

 
This displays the Search dialog box. You can now add item members to the group just created by searching
for items.

• In the first keyword box, type computer*, and then click Search.
• Select the check box next to each item you want to add to the group, and then click Add.
• In the Display list, select Items in Current Group Only.

 
The list refreshes to display only the items you selected and added to the group (Figure 5.5).
 
FIGURE 5.5



Group Editor

© 2014 Mandarin Library Automation, Inc. All rights reserved.
 

28 of 35

 

• Click the Circ Periods tab (Figure 5.6) and establish circulation time frames and fine amounts in
the boxes provided. When finished, click Apply.

 
FIGURE 5.6

 

• Click the Circ Limits tab (Figure 5.7) and establish the circulation quantity limits. Select a limit type check
box, then establish the limit in the corresponding box.

 
FIGURE 5.7
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• When finished, click Apply, and then click OK. This displays the main Group Editor window with
the new group listed.

• To review the Computer Awareness Program group and its attribute, select the group, and then
click Edit.

 
 
VIEWING GROUP INFORMATION
Patron Groups
To review the privileges and parameters of a patron group:

• In the main Group Editor window, select a patron group. (If you don’t have any patron groups,
create one now before proceeding.)

• Click Edit. This displays the Patron Group window.
• Click each tab and review the contents.
• When finished, click Cancel to return to the main Group Editor window.

 
Tip: Use the Item Group Overrides tab to grant  a patron group rights  to over- ride specific circulation limits connected to item
groups. For example, if the item group “General Collection” has a loan period of 14 days, the “Volunteers” patron group could  be
given a loan period of 21 days.
 
NOTE: When the check box corresponding to a feature or limit is selected, the feature or limit is enabled. In this example, the
patron group is comprised of Library Assistants. Therefore, you will notice that the members of this group have more privileges
than general patrons/students and fewer privileges than the professional library staff.
 
Tip: The Members tab lists items assigned to the item group. New items  may be added or removed  when necessary. Items
assigned to this  group adhere to the circulation parameters established in the Circ Periods  tab.
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Item Groups
To review the parameters of an item group:

• In the main Group Editor window, select an item group. (If you don’t have any item groups, create
one now before proceeding.)

• Click Edit. This displays the Item Group window.
• Click each tab and review the contents.
• When finished, click Cancel to return to the main Group Editor window.

 
NOTE: When the check box corresponding to a feature or limit is selected, the feature or limit is enabled.
 
Special Reserve Groups
To review the privileges and parameters of a special reserve group:

• In the main Group Editor window, select a special reserve group. (If you don’t have any special
reserve groups, create one now before pro- ceeding.).

• Click Edit. This displays the Special Reserve Group window.
• Click each tab and review the contents.
• When finished, click Cancel to return to the main Group Editor window.

 
NOTE: When the check box corresponding to a feature or limit is selected, the feature or limit is enabled. In this example, notice
that the tabs Circ Periods, Circ Limits, and Patron Members do not display any information. The items in this special reserve
group are being placed into a display case in the lobby of the library; therefore, the items will not circulate.
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Inventory
OVERVIEW
 
Note: This demonstration guide may not explain  all features available in Inventory.
 
With the Inventory module, you can:

•     Conduct a full or partial inventory
•     Enter additional barcodes after the barcode records have been uploaded
•     Remove barcodes during the inventory process
•     Print and save inventory results
•     Export a barcode list of inventory results
 

 
Conducting an inventory with M3 requires a few basic steps:
1.      Scan items to be inventoried
2.      Upload the results into the Inventory module
3.      Set range limits (partial inventory only)
4.      Perform the “Do Inventory” procedure
 
 
STARTING INVENTORY

• Open the Mandarin M3 folder on your desktop, then double-click the Inven- tory icon. This displays the
Login dialog box.

• In the Login Name box, type admin.
• In the Password box, type boca raton, and then click OK. This displays the Select Inventory Session

window.

 
 
CONDUCTING AN  INVENTORY
This basic example assumes that you have scanned and uploaded barcodes into M3, and then saved the
barcode file. For instructions, refer to the M3 Users Guide.  In the Select Inventory Session window, click
Create New Session. This displays the main Inventory window (Figure 6.1).
 
FIGURE 6.1
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• In the File menu, click Add Barcode File. Navigate to your saved barcode file and click Open.
• In the Barcode pane, click the plus (+) sign next to the barcode file name. This displays the list of

barcodes in the file.
• To review Inventory set-up, click Inventory Options on the Action menu. This displays the

Inventory Options window (Figure 6.2).
 

FIGURE 6.2

 
In this window, you can:
 



Inventory

© 2014 Mandarin Library Automation, Inc. All rights reserved.
 

33 of 35

•     Configure the Inventory module to recognize a specific pattern of characters, a certain
barcode length, or both
•     Indicate a partial inventory by entering the range of call numbers (classification parts)
and selecting a call number prefix

• When finished in this window, click Save.
• On the Action menu, click Do Inventory to run the Inventory procedure. When finished, a dialog

box displays with a summary of the inventory results (Figure 6.3).

 
FIGURE 6.3

 

• Click OK to close the dialog box and return to the main Inventory window.

 
M3 places the appropriate information in each of the nine tabs in the Inventory pane.

•     Newly Found – Lists items present in this barcode upload, but previously flagged as missing.
•     Missing – Lists all items missing from this barcode upload.
•     Invalid Barcodes  – Lists items that do not belong in the collection or have the wrong barcode
length.
•     Misplaced – Lists items that are in the wrong shelf position.
•     Loaned Shelved – Lists items that have an availability status of loaned, but are actually on the
shelf.
•     No Barcode – Lists items that have no barcode on file in the catalog.
•     Duplicate Barcode – Lists items that have duplicate barcodes.
•     Out of Range(s) – Lists items that are not in the inventory call number range, but are in the
barcode upload in shelflist order.
•     Statistics – Displays a summary of the current inventory results, as well as statistics regarding
this inventory.
 

Click each of the tabs in the Inventory pane to view the Inventory results. Now that all the results are compiled,
the reports needed to reconcile the Inventory can be printed from within each tab by clicking  Print [List Type]
List on the File menu.
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Report Tool
 
OVERVIEW
With the ReportTool module, you can:
•     Create and run new reports
•     Access and run preloaded reports
•     Customize your library name on a preloaded report
•     Print reports or download reports to diskette
 
The ReportTool module is a flexible and powerful Windows report generator. More than 900 library-related reports
for school, public, academic, and special libraries are offered. You can run these preloaded reports in their current
form, customize the preloaded reports, or create new reports.
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Contacts & Credits
 

POSTAL ADDRESS
Mandarin Library Automation, Inc.
P.O. Box 272308
Boca Raton, FL 33427-2308
 
PHONES AND FAX
(800) 426-7477 Toll-free
(561) 995-4010 Local
(561) 995-4065 Fax
 
REGULAR OFFICE HOURS
M-F 8:30AM - 5:00PM EST
 
TECHNICAL SUPPORT HOURS
24x7x365 - 24 hours/day, 7 days/week
 
BY EMAIL
Sales & Marketing: automation@mlasolutions.com
Customer Service: automation@mlasolutions.com
Technical Support: support@mlasolutions.com
Webmaster: webmaster@mlasolutions.com
 

 

mailto:automation@mlasolutions.com
mailto:automation@mlasolutions.com
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